Table of Contents

GCI ........................................................................ 2
  Overview ..................................................... 2
  Features ..................................................... 2
Purpose of This Guide ........................................... 3
Representations and Warranties .......................... 3
Applicable Documentation ................................. 3
Application Description ....................................... 5
Installation - Power and Data ............................... 6
  Connect Network and Apply Power ..................... 6
Device Setup and Configuration ......................... 7
  Temporary Ethernet Network ......................... 7
  PC Setup .................................................. 8
  Accessing the GCI ...................................... 8
  Configuring the GCI .................................... 10
Overview of LCI2 Settings ................................. 12
  Configure LCI2 Settings ...................... 14
  Set Up the TCP/IP Configuration ............. 15
Adding iWorx® Controllers ................................ 15
Checking a Controller’s Status ............................ 18
Master Schedule and Device Configuration .......... 18
Alarms ....................................................... 19
Licensing ..................................................... 19
  Example License ...................................... 20
Using a Non-GCI JENE with iWorx® ................. 20
Connecting to the GCI Platform ......................... 21
Software Troubleshooting ................................. 22
  Troubleshooting Tips ................................. 22
**GCI**

The GCI is a microprocessor-based graphical control interface for controlling iWorx® and other controllers over a variety of building automation interfaces.

The Taco GCI consists of a JENEsys® JENE-PC1000 or JENE-PC6000e pre-commissioned with the software, files and licenses needed for easy integration with a network of iWorx® devices.

The GCI is available in two base models:

- **GCI-0XX Family**: For installations of less than 30 controllers.
- **GCI-6XX Family**: For installations of 30 or more controllers, or installations with heavy data-logging needs.

**Overview**

The GCI is a compact, embedded controller/server platform that combines integrated control, supervision, data logging, alarming, scheduling and network management functions with Internet connectivity and web serving capabilities in a small, compact platform. The GCI makes it possible to control and manage iWorx® and other external devices over the Internet and present real time information to users in web-based graphical views.

The JENE-PC1000 or 6000 is a member of the JENEsys® suite of Java-based controller/server products, software applications and tools, all designed to integrate a variety of devices and protocols into unified, distributed systems. JENEsys® products are powered by the revolutionary NiagaraAX Framework®, the industry's first software technology designed to integrate diverse systems and devices into a seamless system. NiagaraAX supports a wide range of protocols including LonWorks™, BACnet™, Modbus, oBIX and Internet standards. The NiagaraAX Framework also includes integrated network management tools to support the design, configuration, installation and maintenance of interoperable networks.

The GCI controller provides control over building automation systems based on the following automation protocols:

<table>
<thead>
<tr>
<th>Product</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GCI-X01</td>
<td>Graphical Control Interface with iWorx® and LonWorks interfaces</td>
</tr>
<tr>
<td>GCI-X02</td>
<td>Graphical Control Interface with iWorx® and BACNet IP interfaces</td>
</tr>
<tr>
<td>GCI-X03</td>
<td>Graphical Control Interface with iWorx® and BACNet MSTP interfaces</td>
</tr>
<tr>
<td>GCI-X04</td>
<td>Graphical Control Interface with iWorx® and MODBUS RTU interfaces</td>
</tr>
<tr>
<td>GCI-X05</td>
<td>Graphical Control Interface with iWorx® and MODBUS TCP interfaces</td>
</tr>
<tr>
<td>GIPS-001</td>
<td>120 VAC 60 Hz power supply for GCI series controls</td>
</tr>
</tbody>
</table>

**Features**

- Compact, embedded controller/server platform
- Integrates control, supervision, data logging, alarming, scheduling, and network management functions
- Internet connectivity and web serving capabilities
- GCI-0XX Family: Embedded PowerPC platform @ 250 MHz
- GCI-6XX Family: Embedded PowerPC platform @ 524 MHz
- Comes standard with two RJ-45 Ethernet ports, one RS-232 port, and one RS-485 port
- Supports BACnet, LON, and Modbus protocols
- Fully customizable with an array of software drivers and custom modules
- All program data is backed up in nonvolatile EEPROM; battery backup
- Onboard Ethernet communication provides rapid data transmission
- Runs stand-alone control, energy management, and multi-protocol Integration
PURPOSE OF THIS GUIDE

The iWorx® GCI Software Installation Guide provides software installation information for the GCI Series controllers. The reader should understand basic HVAC concepts, intelligent environmental control automation, and basic LONWORKS networking and communications. This installation manual is written for:

- Users who engineer control logic
- Users who set up hardware configuration
- Users who change hardware or control logic
- Technicians and field engineers

REPRESENTATIONS AND WARRANTIES

This Document is subject to change from time to time at the sole discretion of Taco Electronic Solutions, Inc. All updates to the Document are available at www.taco-hvac.com. When installing this product, it is the reader’s responsibility to ensure that the latest version of the Document is being used.

iWorx® products shall only be used for the applications identified in the product specifications and for no other purposes. For example, iWorx® products are not intended for use to support fire suppression systems, life support systems, critical care applications, commercial aviation, nuclear facilities or any other applications where product failure could lead to injury to person, loss of life, or catastrophic property damage and should not be used for such purposes.

Taco Electronic Solutions, Inc. will not be responsible for any product or part not installed or operated in conformity with the Document and instructions or which has been subject to accident, disaster, neglect, misuse, misapplication, inadequate operating environment, repair, attempted repair, modification or alteration, or other abuse. For further information, please refer to the last page of this Document for the company’s Limited Warranty Statement, which is also issued with the product or available at www.taco-hvac.com.

APPLICABLE DOCUMENTATION

See the table below for additional documentation that may be applicable to this controller.

<table>
<thead>
<tr>
<th>Description</th>
<th>Audience</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>JENE NiagaraAX Install &amp; Startup Guide</td>
<td>– Application Engineers</td>
<td>Provides instructions for setting up and using JENE NiagaraAX technology.</td>
</tr>
<tr>
<td></td>
<td>– Installers</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– Service Personnel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– Start-up Technicians</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– End user</td>
<td></td>
</tr>
<tr>
<td>JENE-PC1000 Series Cutsheet JENE-PC6000e Series Cutsheet</td>
<td>– Application Engineers</td>
<td>Provides abbreviated information about the JENE-PC1000/6000e product line.</td>
</tr>
<tr>
<td></td>
<td>– Installers</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– Service Personnel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– Start-up Technicians</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– End user</td>
<td></td>
</tr>
<tr>
<td>JENEsys JENE-PC1000 -PC6000e Installation Guide.pdf</td>
<td>– Application Engineers</td>
<td>Provides instructions for setting up and using JENE-PC1000 to PC6000e products.</td>
</tr>
<tr>
<td></td>
<td>– Installers</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– Service Personnel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– Start-up Technicians</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– End user</td>
<td></td>
</tr>
<tr>
<td>iWorx® LCI2 Application Guide, Document No. 505-002</td>
<td>– Application Engineers</td>
<td>Provides instructions for setting up and using the iWorx® Local Control Interface.</td>
</tr>
<tr>
<td></td>
<td>– Installers</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– Service Personnel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– Start-up Technicians</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– End user</td>
<td></td>
</tr>
</tbody>
</table>
### Description

**iWorx® GCI Software Installation Guide, (this document)**

- Application Engineers
- Installers
- Service Personnel
- Start-up Technicians
- End user

**http://www.iWorxWizard.com**

- Application Engineers
- Wholesalers
- Contractors

**Additional Documentation**

For more information on configuring and using the JENE controller, consult the following documents available from the secure section of www.lynxspring.com:

- JM16 Installation and Configuration Instructions
- JM34 Installation and Configuration Instructions
- JCOM-1LON Option Installation Guide
- JENEsysTM JENE-PC1000-PC6000e Mounting and Wiring Instructions
- JCOM-2485 Option Installation Guide
- JCOM-56KM Option Installation Guide
- JNEPC-LCD User Guide
- NiagaraAX Ndio Guide
- NiagaraAX User Guide

### Audience

- **Application Engineers**
- **Installers**
- **Service Personnel**
- **Start-up Technicians**
- **End user**

### Purpose

Provides instructions for setting up and using the GCI Series software.

An on-line configuration and submittal package generator based on user input. Automatically generates bill of materials, sequence of operations, flow diagrams, wiring diagrams, points and specifications.

For more information on configuring and using the JENE controller, consult the following documents available from the secure section of www.lynxspring.com:
APPLICATION DESCRIPTION

The following diagram illustrates typical system topology:

Figure 1: Typical System Topology
Connect Network and Apply Power

1. Connect Echelon Approved Level IV Cable to the LON iWorx® port.
   
   **NOTE:** This port is to be used for a network of iWorx® controllers only.

2. Attach one end of a category-5 Ethernet unshielded twisted pair (UTP) cable to the LAN1 (and if needed) LAN2 Ethernet connector(s) on the GCI. For this initial Ethernet connection, use either:
   
   a. A standard patch cable with the other end connected to an Ethernet hub, switch, or port, or
   
   b. A "crossover" cable with the other end connected directly to a PC

3. Connect power to the GCI.
DEVICE SETUP AND CONFIGURATION

Temporary Ethernet Network
A temporary Ethernet network is required for initial configuration of the GCI. The following IP addresses are suggested during initial configuration:

Table 1: IP Address Suggestions

<table>
<thead>
<tr>
<th>Setting</th>
<th>LAN 1</th>
<th>LAN 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-configured GCI IP Address</td>
<td>192.168.1.101</td>
<td>10.2.1.101</td>
</tr>
<tr>
<td>Suggested LCI2 IP Address</td>
<td>192.168.1.100</td>
<td>10.2.1.100</td>
</tr>
<tr>
<td>Suggested Local Client PC IP Address</td>
<td>192.168.1.102</td>
<td>10.2.1.102</td>
</tr>
</tbody>
</table>

Figure 3: Example of a Temporary Network Using a Hub
NOTE: To add iWorx® controllers to the GCI, the GCI must communicate with an LCI over its Ethernet connection.

If iWorx® controllers are to be added to the GCI while the GCI is operating on a temporary Ethernet network, then the temporary Ethernet network will need to be extended to include the LCI.

If the GCI will be re-configured for a permanent network before the iWorx controllers are added to the GCI, then the LCI does not need to be configured on this temporary network.

The GCI and LCI must be operating on both the same Ethernet network and the same LON network before iWorx® controllers can be successfully added to the GCI.

PC Setup

Configure the PC as follows:

1. If the PC is not connected directly to the GCI, physically connect the PC to same network hub or switch as the GCI by using a standard patch cable.
2. Record the PC's IP address and subnet mask.
3. Determine whether the GCI's Ethernet cable is connected to LAN1 or LAN2.
   Note: Refer to Figure 2 for help determining whether LAN1 or LAN2 is being used.
4. Assign a new IP address to the PC (see suggestions in Table 1 on page 7):
   Note: Advanced users may use an alternate IP address, but do not assign the same IP address to both the PC and the GCI.
5. Set the PC's subnet mask to 255.255.255.0.
   Note: If necessary, refer to the Operating System's instructions for information about configuring TCP/IP settings.

Accessing the GCI

The GCI may be accessed through a web browser or Probuilder software installed on the client PC.

Access the GCI from a Browser

GCI setup may be performed by using a Java-capable web-browser from a properly configured PC.

Note: See the PC Setup section for instructions on configuring the PC's network settings.

1. Open the browser to one of the default web addresses (see suggestions in Table 1 on page 7).
   Note: Refer to Figure 2 for help determining whether LAN1 or LAN2 is being used.
2. Login with the default station credentials as shown in Figure 4:
   Username: admin
   Password: iWorx1234
Access the GCI from ProBuilder

**NOTE:** These instructions assume NiagaraAX ProBuilder is already installed onto the client PC.

To open the station:

1. Start ProBuilder. The Nav tree should be visible in the side bar area (left pane).
   If not, select Window > Side Bars > Nav from the menu bar
2. Once the GCI has powered up, connect to it with ProBuilder.
   Select File > Open > Open Station.

**Figure 5: Connecting with ProBuilder**
3. Complete the fields in the Open Station dialog box as follows:

**Figure 6: Open Station**

![Open Station dialog box](image)

**Configuring the GCI**

GCI configuration may be performed either using the web browser or Probuilder software. Since the GCI contains a built-in web interface and all hardware and software for commissioning the GCI to interface with an iWorx® network of devices, traditional JENE commissioning is not required. Probuilder software is not required unless more advanced customization is desired.

**Device Configuration**

To use the Device Configuration page to setup the device, first click Device Configuration at the top of the Home page as shown:

**Figure 7: Device Configuration**

![Device Configuration](image)
When viewing the Device Configuration page, the Home button is present and the User Management and Device Configuration tabs are displayed.

**Figure 8: Device Configuration - Home & User Management**

Configure Users
The User Management tab is displayed first when the Device Configuration page is opened.

**Figure 9: User Management**

- Double-click any user to change default credentials.
- Add a new user by clicking New at the bottom of the screen.

**NOTE:** Specific details on adding and configuring users are outside the scope of this document. For more help, consult a Niagara Certified Professional.

**NOTE:** Change all pre-configured users’ passwords (such as admin) to prevent unauthorized access to the system.
Configure the Date / Time
To set the system Date / Time from the Device Configuration tab:
1. Change the date and time.
2. Save the changes.
Figure 10: Configure Date and Time

Configure the Weather Service Provider
Weather Service data can be used for populating Outside Air Temperature.
To set the Weather Service Provider from the Device Configuration tab:
1. Update the Provider state and city.
2. Save the changes.
Figure 11: Configure Weather Service Provider

NOTE: For the Weather Service Provider to function correctly, the GCI must have a properly configured LAN interface including a valid DNS Server entry.

Overview of LCI2 Settings
An iWorx® LCI2 is required for the GCI to operate with iWorx® controllers. If the LCI2 is not properly configured, the GCI does not recognize iWorx® controllers.
The LCI2 is used for configuring individual iWorx® controller settings. The GCI launches a web browser session to the LCI2 when the user clicks the Device Configuration button on the GCI's Home page.

NOTE: For information on configuring controllers, refer to the Master Schedule and Device Configuration section.

When the GCI communicates with the LCI on the LCI's service port, the LCI Address is used.
When a remote client launches to the LCI through the GCI, the remote client browser is provided with the Public Address and HTTP Port.
The figure below details the application of the LCI Configuration settings.

**Figure 12: LCI2 Settings**

<table>
<thead>
<tr>
<th>LCI Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>LCI Address 192.168.1.100</td>
</tr>
</tbody>
</table>

**NOTE:** The network administrator must configure NAT/port forwarding so that a connection from a Remote Client to the LCI2 by using the Public Address and HTTP Port is routed to the LCI2 operating on the local network at the LCI Address and HTTP Port.

The GCI opens a browser to the Public Address and HTTP Port (65.206.23.148:11001) whenever the LCI must be accessed for controller configuration.

The GCI obtains additional network data from the LCI by using the LCI Address and LCI Service Port (192.168.1.100, Port is 11000)
Configure LCI2 Settings

To set the LCI2 Configuration from the Device Configuration tab:

1. Set the Local LCI IP Address.
2. Set the Public LCI IP Address.
3. Set the LCI HTTP Port.
4. Save the changes.

**Figure 13: LCI2 Configuration**

**NOTE:** If a public address is not desired for the LCI, the Local LCI IP Address must be repeated in the Public Address field.
Set Up the TCP/IP Configuration

To set the minimal TCP/IP Configuration from the Device Configuration tab:

1. Set the IPv4 Gateway.
2. Enter DNS Servers (required if the Weather Service Provider will be used).
3. Expand Interface 1 or Interface 2 (corresponding to the physical interface port named LAN1 or LAN2 respectively).
4. Configure IPv4 Address and IPv4 Subnet Mask.
5. Save changes.

Figure 14: TCP/IP Configuration

NOTE: In any subsequent platform session after the GCI is commissioned, log in using any new (changed) parameters, such as IP address, Port, Credentials. If the PC’s IP address was changed to a temporary value, it must be re-configured to the appropriate TCP/IP settings to communicate to the newly commissioned GCI.

ADDING IWORX® CONTROLLERS

NOTE: To add iWorx® controllers to the GCI, the GCI must communicate with an LCI over its Ethernet connection.

The GCI and LCI must be operating on both the same Ethernet network and the same LON network before iWorx® controllers can be successfully added to the GCI.
To add iWorx® controllers to the GCI:

1. Click the Home button:

   **Figure 15: Home Button**

   ![Home Button Image](image)

When the Home page is displayed, the Device Configuration button is present and both the iWorx® Equipment Status and the Alarm Console are available:

**Figure 16: Device Configuration Button**

![Device Configuration Button Image](image)
2. Click the Learn Devices button on the right-hand side of the page to add new controllers to the GCI.

**Figure 17: Learn Devices Button**

![Learn Devices Button](image)

**NOTE:** Controllers must be configured properly on the LCI2 before they may be added to the GCI. Please see the [LCI2 Application Guide](#) for instructions on how to add iWorx® controllers to the LCI2.

3. After a moment, a Success notification is displayed:

**Figure 18: Success Message**

![Success Message](image)

4. From the menu, choose Config > Services > JobService > TacoDiscoveryJob to report all controllers on the network.

**Figure 19: Discovery Job**

![Discovery Job](image)

5. Any controller successfully recognized by the GCI shows as a match under Drivers > TacoLonNetwork > TacoLonHarmonyDiscoveryHvac, and the controller has an entry under Drivers > TacoLonNetwork according to the controller's Device Name:

**Figure 20: Controller Recognition**

![Controller Recognition](image)

6. A controller that is successfully recognized by the GCI appears under iWorx® Equipment Status:
Figure 21: Equipment Status Display

<table>
<thead>
<tr>
<th>iWorx Status</th>
<th>Other Device Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>iWorx Equipment Status</th>
<th>Display Name</th>
<th>NeuronId</th>
<th>Subset/Node</th>
<th>ProgramId</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit_1_DiUS</td>
<td>00 21 89 41 50 00 1/1</td>
<td>44 58 55 34 00 00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit_2_DiUS3</td>
<td>00 21 89 05 99 00 1/2</td>
<td>44 58 55 33 00 00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** You may need to click **Refresh** to see newly added controllers.

**CHECKING A CONTROLLER’S STATUS**

To see a controller's status, double-click its entry in the iWorx® Equipment Status table. Unit Status is displayed on the screen:

![Unit Status Display](image)

**NOTE:** The graphical representations for each iWorx® controller are pre-configured to match the most common applications for the controller. The JENE platform also provides flexibility for updating those graphics so that alternate applications of the same controller may be modeled exactly to meet customer needs.

Contact the Niagara Certified Professionals at Taco for help with modifying controller graphics.

**MASTER SCHEDULE AND DEVICE CONFIGURATION**

The operating schedule and other settings for the iWorx controllers are set by the LCI2.
Click the Configuration button to open a browser session to the LCI2 and configure the controller.

**Figure 23: Configuration**

![Configuration](image)

**NOTE:** Consult the LCI2 Application Guide for instructions on setting the iWorx® operating schedule.

**NOTE:** The Master Schedule button displayed on the GCI while viewing iWorx® controller status is used ONLY for BACnet and non-iWorx® LON devices (interfaced through Option Slot 2 on the JENE).

**ALARMS**

Device specific alarms are displayed by the LCI2.

Click the Alarms button to open a browser session to the LCI2 and display device specific alarms.

**Figure 24: Alarms**

![Alarms](image)

**LICENSING**

The Taco GCI has the following Licenses and Certificates pre-installed:

- Lynxspring.license
- TACO.license
Figure 25: Licenses

These licenses unlock the additional iWorx® graphical capabilities built into the GCI.

Example License

By clicking on a license or certificate and then clicking View, you can see the XML contents of the license file. An example is shown here:

```xml
<license version="3.6" vendor="Tridium" generated="2012-02-17" expiration="never" hostId="Qnx-xxxx-xxxx-xxxx-xxxx" serialNumber="xxxxxx">
  <feature name="brand" accept.station.in="*" accept.station.out="*" accept.wb.out="*" brandId="TACO" accept.wb.in="*"/>
  <feature name="about" project="0013073 / R207561" owner="Lynxspring"/>
  <feature name="adr" expiration="never" point.limit="none" history.limit="none" device.limit="1" parts="TACO-PC1"/>
  <feature name="dataRecovery" expiration="never" parts="TACO-PC1"/>
  <feature name="email" expiration="never" parts="TACO-PC1"/>
  <feature name="ibmj9j2me" expiration="never" rev="2.3" parts="TACO-PC1"/>
  <feature name="jennic" expiration="never" parts="TACO-PC1"/>
  <feature name="lonworks" expiration="never" schedule.limit="none" point.limit="none" history.limit="none" device.limit="none" parts="Z-DR-LON-2"/>
  <feature name="maxHeap" expiration="never" parts="Z-NPM-128"/>
  <feature name="modbusAsync" expiration="never" schedule.limit="none" point.limit="none" history.limit="none" device.limit="none" parts="Z-DR-MRTU-2"/>
  <feature name="ndio" expiration="never" schedule.limit="none" point.limit="none" history.limit="none" device.limit="none" parts="TACO-PC1"/>
  <feature name="niagaraDriver" expiration="never" schedule.limit="none" point.limit="0" history.limit="0" device.limit="0" parts="TACO-PC1"/>
  <feature name="nrio" expiration="never" schedule.limit="none" point.limit="none" history.limit="none" device.limit="4" parts="TACO-PC1"/>
  <feature name="obixDriver" expiration="never" schedule.limit="none" foreignPoint.limit="none" export="true" point.limit="none" history.limit="none" foreignHistory.limit="none" device.limit="none" foreignDevice.limit="none" foreignSchedule.limit="none" foreignDevice.limit="none" parts="TACO-PC1"/>
  <feature name="serial" expiration="never" parts="TACO-PC1, Z-DR-MRTU-2"/>
  <feature name="station" expiration="never" parts="TACO-PC1"/>
  <feature name="web" expiration="never" ui="true" ui.wb="true" ui.wb.admin="true" parts="Z-UI-SP-2XX, Z-WP-2-WEB"/>
</license>
```

USING A NON-GCI JENE WITH IWORX®

The GCI consists of a JENEsys® JENE-PC1000 pre-commissioned with the right software, files and licenses for easy, straight-forward integration with a network of iWorx® devices. Alternatively:

- For customers who do not require graphical representations of HVAC systems, the lonTaco.jar file is available.
- For customers who require all capabilities of the GCI, additional files and licensing are available.
Please contact Taco support for assistance.

**CONNECTING TO THE GCI PLATFORM**

A platform connection to any GCI is required for many advanced host-level operations. This includes installing Niagara AX core software and modules and performing various other tasks. After you open a platform connection, you can run the Commissioning Wizard.

To open the platform:

1. Start ProBuilder. The Nav tree should be visible in the side bar area (left pane). If it is not visible, select:
   
   Window > Side Bars > Nav from the menu bar.

2. Connect to the GCI with ProBuilder when it has powered up (which may take several minutes). From the menu bar, select:
   
   File > Open > Open Platform.

3. Complete the fields in the Open Platform dialog box as follows:

![Figure 26: Platform Connection](image)

   - Host: LAN1: 192.168.1.101
     
   - LAN2: 10.2.1.101
     
   - Port: 3011
     
   - Username: taco
     
   - Password: iWorx1234

4. Click the OK button to accept all settings.
   
   The Platform opens in the tree, and its Nav Container View displays in the view pane.
Figure 28: Connected Platform

<table>
<thead>
<tr>
<th>Platform</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Application Director</td>
<td>Control applications and access console output</td>
</tr>
<tr>
<td></td>
<td>DDNS Configuration</td>
<td>Configure the way DDNS operates.</td>
</tr>
<tr>
<td></td>
<td>Dialup Configuration</td>
<td>Configure the way the remote host uses dialup networking</td>
</tr>
<tr>
<td></td>
<td>Distribution File Installer</td>
<td>Install distribution files to the remote host</td>
</tr>
<tr>
<td></td>
<td>File Transfer Client</td>
<td>Transfer files to and from the remote host</td>
</tr>
<tr>
<td></td>
<td>GPRS Modem Configuration</td>
<td>Configure and Monitor GPRS modem</td>
</tr>
<tr>
<td></td>
<td>Lexicon Installer</td>
<td>Install lexicons to support additional languages</td>
</tr>
<tr>
<td></td>
<td>License Manager</td>
<td>Manage licenses and certificates</td>
</tr>
<tr>
<td></td>
<td>Platform Administration</td>
<td>Update the platform daemon’s port or credentials, or set</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Station (taco)</td>
<td></td>
</tr>
</tbody>
</table>

SOFTWARE TROUBLESHOOTING

Troubleshooting Tips

The table below provides solutions to some common problems you may encounter.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>No controllers appear after clicking Learn Devices button.</td>
<td>Controllers have not been added to LCI2: Use the service pin on each controller to establish a link with the LCI2. Refer to the LCI2 Application Guide for more information. LCI2 is not properly configured: Be sure the LCI2 is operating on the same LON iWorx® network and Ethernet network as the GCI and that LCI Configuration settings are properly configured. Follow the Configure LCI2 Settings section when configuring the LCI2. Page is not refreshed: Use the refresh button to re-load the page. Unidentified controller: Follow the Add iWorx® Controllers section when adding controllers and diagnosing issues. Please contact Taco for more assistance.</td>
</tr>
</tbody>
</table>
**LIMITED WARRANTY STATEMENT**

Taco Electronic Solutions, Inc. (TES) will repair or replace without charge (at the company's option) any product or part which is proven defective under normal use within one (1) year from the date of start-up or one (1) year and six (6) months from date of shipment (whichever occurs first).

In order to obtain service under this warranty, it is the responsibility of the purchaser to promptly notify the local TES stocking distributor or TES in writing and promptly deliver the subject product or part, delivery prepaid, to the stocking distributor. For assistance on warranty returns, the purchaser may either contact the local TES stocking distributor or TES. If the subject product or part contains no defect as covered in this warranty, the purchaser will be billed for parts and labor charges in effect at time of factory examination and repair.

Any TES product or part not installed or operated in conformity with TES instructions or which has been subject to accident, disaster, neglect, misuse, misapplication, inadequate operating environment, repair, attempted repair, modification or alteration, or other abuse, will not be covered by this warranty.

TES products are not intended for use to support fire suppression systems, life support systems, critical care applications, commercial aviation, nuclear facilities or any other applications where product failure could lead to injury to person, loss of life, or catastrophic property damage and should not be sold for such purposes.

If in doubt as to whether a particular product is suitable for use with a TES product or part, or for any application restrictions, consult the applicable TES instruction sheets or in the U.S. contact TES at 401-942-8000 and in Canada contact Taco (Canada) Limited at 905-564-9422.

TES reserves the right to provide replacement products and parts which are substantially similar in design and functionally equivalent to the defective product or part. TES reserves the right to make changes in details of design, construction, or arrangement of materials of its products without notification.

TES OFFERS THIS WARRANTY IN LIEU OF ALL OTHER EXPRESS WARRANTIES. ANY WARRANTY IMPLIED BY LAW INCLUDING WARRANTIES OF MERCHANTABILITY OR FITNESS IS IN EFFECT ONLY FOR THE DURATION OF THE EXPRESS WARRANTY SET FORTH IN THE FIRST PARAGRAPH ABOVE.

THE ABOVE WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR STATUTORY, OR ANY OTHER WARRANTY OBLIGATION ON THE PART OF TES.

TES WILL NOT BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OF ITS PRODUCTS OR ANY INCIDENTAL COSTS OF REMOVING OR REPLACING DEFECTIVE PRODUCTS.

This warranty gives the purchaser specific rights, and the purchaser may have other rights which vary from state to state. Some states do not allow limitations on how long an implied warranty lasts or on the exclusion of incidental or consequential damages, so these limitations or exclusions may not apply to you.